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ВВЕДЕНИЕ 

Использование современных компьютерных технологий 
широко применяется в науке и промышленности.  

В данном пособии рассмотрены основные программные 
продукты, которые используются студентами по направлениям 
16.03.01 «Техническая физика», 28.03.01 «Нанотехнологии и 
микросистемная техника», 14.03.01 «Ядерная энергетика и теп-
лофизика» очной формы обучения. 

В первом разделе кратко рассмотрены базовые инстру-
менты компьютерной программы КОМПАС-График. Данная 
версия распространяется бесплатно для учебных и ознакоми-
тельных целей. Также в приложениях представлены варианты 
заданий для выполнения и контрольные вопросы для самопро-
верки. 

Второй раздел пособия посвящен компьютерной про-
грамме SciDAVis, который используется для построения гра-
фиков и анализа данных. Приведены основные возможности 
работы в программе с дополнительными авторскими примеча-
ниями. Раздел также включает контрольные вопросы для само-
проверки. 

Третий раздел, посвященный компьютерной программе 
Microsoft Word, нацелен на расширение знаний обучающихся и 
позволяет научиться использовать встроенные возможности по 
автоматизации работы с документом. Раздел также включает 
практические примечания автора и контрольные вопросы для 
самопроверки. 

 
  



 

1. Выполнение чертежей деталей 

Цель работы: Выполнение чертежей по ЕСКД в про-
грамме КОМПАС-График Учебная версия 

1.1. Основы работы в программе 
1.1.1. Описание программы 

КОМПАС-График — универсальная система автомати-
зированного проектирования, позволяющая в оперативном ре-
жиме выпускать чертежи изделий, схемы, спецификации, таб-
лицы, инструкции, расчетно-пояснительные записки, техниче-
ские условия, текстовые и прочие документы. Изначально си-
стема ориентирована на оформления документации в соответ-
ствии с ЕСКД, ЕСТД, СПДС и международными стандартами, 
но этим возможности системы не ограничиваются. 

Гибкость настройки системы и большое количество 
прикладных библиотек и приложений позволяют выполнить 
практически любую задачу пользователя, связанную с выпус-
ком документации для всех отраслей. А поддержка распро-
страненных форматов DXF/DWG дает возможность организо-
вывать эффективный обмен данными со смежными организа-
циями и заказчиками, использующими любые чертежно-
графические системы. 

Современное проектирование машиностроительных из-
делий и строительных конструкций практически невозможно 
без использования трехмерного моделирования. Для автомати-
зации большого количества рутинных процессов (получения 
ассоциативных проекций по модели изделия, автоматического 
построения разрезов/сечений, автоматического обозначения 
центров, формирования спецификаций и отчётов и др.) реко-
мендуем использовать КОМПАС-График в связке с системой 
трехмерного моделирования КОМПАС-3D. Общий вид про-
граммы показан на рис. 1.1.  



 

 

Рис. 1.1. Общий вид программы КОМПАС-3D 

На рис. 1.2 показаны окно настройки интерфейсов про-
граммы. Используя данные инструменты, вы можете оформ-
лять чертежи. 

 

 

Рис. 1.2. Интерфейс «Черчение» 



 

КОМПАС-3D Учебная версия открывает школьникам и 
студентам весь спектр профессиональных возможностей 
КОМПАС-3D, ведь в ней есть все приложения и библиотеки. 
Учебная версия поможет выполнять курсовые, расчетно-
графические и дипломные работы любой сложности и подго-
товиться к реальной работе на предприятии [1].  

В графах основной надписи и дополнительных графах 
указывают значения согласно ГОСТ 2.104-2006 [3]. 

Для заполнения основной надписи чертежа дважды 
кликните на выбранное поле и приступайте к редактированию. 
По завершению редактирования необходимо применить вы-
полненные изменения, для этого примените соответствующее 
действие на нижней панели инструментов или нажмите на кла-
виатуре сочетание Ctrl+Enter. 

 

 

Рис. 1.3. Параметры программы 



 

Стоит обратить внимание, что каждая группа инстру-
ментов интерфейса содержит альтернативные инструменты, 
которые могут быть вызвана долгим нажатием ЛКМ на вы-
бранном инструменте. Это может значительно помочь при 
оформлении чертежа.  

При наведении ЛКМ на любой инструмент отобразиться 
всплывающая подсказка с описанием возможности инструмен-
та. 

При необходимости изменить формат чертежа необхо-
димо на верхней панели инструментов выбрать «Настройка – 
Параметры – Текущий чертеж – Параметры первого листа – 
Формат». В результате появится окно (рис. 1.3), в котором 
можно изменить параметры листа, например, установить фор-
мат листа в значение А3.  

1.2. Порядок выполнения работы 

Для успешного выполнения работы необходимо выпол-
нить чертежи деталей (Приложение 1, Приложение 2) в соот-
ветствии с порядковым номером студента в учебной ведомо-
сти; распечатать и вставить в отчет в качестве Приложений. 

1.3. Контрольные вопросы 

1.3.1 Какие панели инструменты вы научились ис-
пользовать при работе с программой? 

1.3.2 Поясните возможности всех инструментов груп-
пы «Геометрия» и «Редактирование». 

1.3.3 Каким образом можно сбросить настройки про-
граммы? 



 

2. Обработка экспериментальных результатов 

Цель работы: научиться использовать основные воз-
можности компьютерных программы SciDAVis для анализа 
научных данных, их визуализации и подготовки к печати  

2.1. Основы работы компьютерной программы 

Одним из средств визуализации данных в научных рабо-
тах, отчетах и презентациях являются графики. В данной рабо-
те рекомендуется использовать программу SciDAVis [5], кото-
рая является бесплатным аналогом по отношению к программе 
OriginPro [7]. 

2.1.1. Построение графиков 

Начальное окно программы состоит из нескольких па-
нелей инструментов и основного рабочего окна (рис. 2.1). 

В новом окне вы увидите таблицу Table1, в которую за-
носятся значения точек для оси X и Y.  

По умолчанию название колонки обозначено порядко-
вым номером. Изменить название можно на вкладке управле-
ния Description в поле Name, а в поле Comment при необхо-
димости можно добавить примечание для значений в колонке 
(рис. 2.2). После внесения изменений в поля нужно сохранить 
действия нажатием на кнопку Apply. 

Чтобы показать панель управления нужно на панели ин-
струментов выбрать Table → Show Controls (или на клавиату-
ре нажать кнопку F12). 

Чтобы добавить новую колонку в таблицу на панели ин-
струментов выберите Table  Add Column. Таким образом вы 
можете создавать необходимое количество колонок. Обратите 
внимание, что новые колонки по умолчанию имеют значения 
для оси Y. Чтобы изменить значение оси выбранной колонки, 



 

на панели инструментов выберите Table  Set Column(s) As и 
установите необходимое значение оси: X, Y или Z. 

Выполнять обработку исходных данных рекомендуется, 
создавая дополнительные колонки, в которых и выполнять об-
работку или преобразование значений исходных данных. Такой 
подход позволит сохранить первоначальные значения и вно-
сить корректировки в преобразования этих данных.  

Примечание: всегда храните исходные данные в от-

дельных колонках и используйте новые колонки для обработки 

данных, так как выражение, составленное внутри колонки, 

может привести к изменению значений самой этой колонки. 

Например, внутри колонки «1» строго не рекомендуется ис-

пользовать ссылку в выражении на саму колонку «1». Такое 

действие приведет к потере исходных данных. 

 

 

Рис. 2.1. Общий вид программы 



 

 

Рис. 2.2. Вкладка управления Description 

Для преобразования значений можно использовать ма-
тематические выражения и встроенные переменные, которые 
необходимо вводить в поле Formula в соответствующей 
вкладке Formula панели управления (рис. 2.3). 

 

 

Рис. 2.3. Вкладка управления Formula 

Например, если необходимо, чтобы все значения в ко-
лонке были равны значению порядкового номера строки, то 
необходимо составить выражение вида  

 



 

�, (2.1) 
 
где � – индексное значение строки. 

Также иногда возникает задача, когда необходимо ука-
зать изменение данных относительно значений из другой ко-
лонки, используя встроенные переменные. Например, выраже-
ние вида  

 
col�"1"� ∗ 10, (2.2) 

 
где col�"1"� – значение из колонки с именем «1» для соответ-
ствующего индекса строки из данной таблицы. 

При необходимости можно использовать встроенные 
математические функции, которые представлены в списке ни-
же поля ввода формулы. 

Для построения графика необходимо выделить колонку 
Y c соответствующими значениями и на панели инструментов 
выбрать Plot → Line + Symbol. В результате появится окно 
Graph1 (рис. 2.4).  

 

 

Рис. 2.4. Окно графика 



 

Для удобства навигации между построенными графика-
ми и таблицами с данными в программе предусмотрено окно 
навигации проекта Project Explorer, которое можно активиро-
вать на панели инструментов View → Project Explorer или 
может быть вызвана с клавиатуры командой Ctrl+E. 

2.1.2. Редактирование графика 

Для редактирования настроек графика в окне 
Plot Details необходимо выбрать на панели инструментов For-

mat → Plot… и в результате появится окно (рис. 2.5), в кото-
ром можно изменять настройки фона, шрифтов, типа кривой, 
цвета точек и линий и т.д. 

 

 

Рис. 2.5. Окно Plot Details для редактирования графика 

Для редактирования настроек шкалы, осей и сетки гра-
фика в окне General Plot Options необходимо выбрать на па-
нели инструментов либо Format → Scales…, либо For-

mat → Axes…, либо Format → Grid…. В результате появится 
окно с соответствующими кладками (рис. 2.6), в котором мож-
но изменять настройки фона, шрифтов, типа кривой, цвета то-
чек и линий и т.д. 



 

 

Рис. 2.6. Окно General Plot Options для редактирования шкалы, 
осей и сетки графика 

2.1.3. Редактирование слоя на графике 

Для добавления нового слоя на график на панели ин-
струментов выберите Graph → Add/Remove Curve… или на 
клавиатуре нажмите Alt+C. В результате появится окно (рис. 
2.7).  



 

 

Рис. 2.7. Окно Add/Remove Curves для редактирования  
слоев графика 

В окне Add/Remove Curves можно добавлять или уда-
лять новые слои на графике, редактировать диапазон видимых 
значения кривой, изменять тип кривой, устанавливать соответ-
ствие колонок и осей кривой и т.д. 

2.1.4. Добавление нового слоя на график 

Возможности программы позволяют добавлять несколь-
ко слоев на один график. Чтобы добавить новый слой на актив-
ный график необходимо выбрать на панели инструментов 
Graph → Add Layer или вызвать команду с клавиатуры Alt+L. 

Для подтверждения добавления нового слоя появится 
окно, в котором необходимо выбрать Guess, чтобы автомати-
чески оптимально распределить все слои на графике. При 
необходимости чтобы автоматически распределить все слои на 



 

графике можно воспользоваться командой на панели инстру-
ментов Graph → Automatic Layout. 

Для переключения между слоями нужно активировать 
кнопку с номером слоя, которая находится в верхнем левом уг-
лу окна графика, например на рис. 2.8 показано окно графика с 
активным слой под номером 3. 

 

 

Рис. 2.8. Окно графика, включающее 4 пустых слоя 

Примечание. Необходимо обратить внимание, что дей-

ствие удаления слоя применяется только к активному в дан-

ный момент слою. 

2.2. Порядок выполнения работы 

Перед выполнение работы рекомендуется ознакомиться 
с основами работы в программе [6]. 



 

1. Создайте новый проект File → New → New Project и 
в процессе работы не забывайте периодически сохраняйте его 
File → Save Project. Все результаты выполняемой работы 
необходимо сохранять в виде рисунков (с поясняющими запи-
сями) в документе программы Microsoft Word. 

2. В таблице Table1 установите (с помощью математи-
ческого выражения и встроенных переменных) 50 значений 
для колонки X в диапазоне от 0 с шагом 25. Для колонки Y 
установите значения в соответствии с зависимостью вида  

 
� = 
 ∗ ���∗� + �, (2.3) 

 
где 
, �, � – коэффициенты уравнения, которые приведены для 
каждого варианта в таблице. 
 

Таблица 1. Коэффициенты уравнения 
Вариант A B C 

1 1500 -0,0015 10 
2 1450 -0,0025 20 
3 1400 -0,0035 30 
4 1350 -0,0045 40 
5 1300 -0,0055 50 
6 1250 -0,0065 60 
7 1200 -0,0075 70 
8 1150 -0,0085 80 
9 1100 -0,0095 90 
10 1050 -0,0105 100 
11 1000 -0,0115 110 
12 950 -0,0125 120 
13 900 -0,0135 130 
14 850 -0,0145 140 
15 800 -0,0155 150 
16 750 -0,0165 160 
17 700 -0,0175 170 
18 650 -0,0185 180 
19 600 -0,0195 190 
20 550 -0,0205 200 



 

Примечание. Используйте встроенные функции в окне 

Formula. Например, экспоненциальная функция ������ позво-

ляет вычислить число Эйлера в заданной степени ��, 

т.е. ������ = �� 

3. Используя полученные координаты точек, постройте 
график Graph1.  

4. Добавьте новый слой на график. Произвольно изме-
ните цвет, стиль и толщину линий графика; способ соединения 
точек; форму и размер отображаемых точек; размер шрифта и 
интервал разметки осей и т.д. Нанесите сетку на системы коор-
динат и научитесь изменять толщины и цвет линий сетки. В 
результате получится «особенный» стиль оформления. 

5. Добавьте еще два новых слоя на график. На слое 3 по-
стройте кривую из таблицы Table1 и задайте интервал значе-
ний с 1 по 25 точку. На слое 4 постройте кривую из таблицы 
Table1 и задайте интервал значений с 26 по 50 точку. 

6. Каждый слой должен иметь подписи к осям, заголо-
вок слоя, подписи для кривых. Оформите в соответствии усло-
вием, что в таблице Table1 представлены экспериментальные 
данные зависимости R(T) электрического сопротивления R (в 
омах) от температуры T (в кельвинах) для образца с номером 
вашего варианта. Результирующий график сохраните в отчет. 

Примечание. Нажмите правой кнопкой мыши в окне 

графика и выберите Copy Page, чтобы скопировать текущее 

окно графика в буфер обмена, и вставить. 

7. В окне Project Explorer добавьте новое окно Graph2, 
в котором необходимо создать 4 слоя и добавить на все слои 
данные из таблицы Table1. 

8. В окне Graph2 постройте на каждом слое полиномы 
2, 4, 6 и 8 порядков соответственно. Результирующий график 
сохраните в отчет. Дополните отчет записями с уравнениями 
полиномов и значениями коэффициентов. 



 

2.3. Тестирование 

По требованию преподавателя будьте готовый проде-
монстрировать действие в программе, которое требовалось для 
выполнения задания. 

3. Оформление отчетной документации 

Цель работы: научиться разрабатывать и оформлять 
отчетную документацию в соответствии с требованиями орга-
низации. 

Программное обеспечение: Microsoft Word 

3.1. Основы работы в программе 

В современном мире для работы с документами суще-
ствует множество программных продуктов: «Microsoft Word» 
[11], «МойОфис» [12], «Google Документы» [13] и др. В данной 
работе мы будем использовать возможности текстового про-
цессора Microsoft Word. 

3.1.1. Подготовка и настройка 

Настройка программы является важным начальным эта-
пом работы. Мы будем выполнять настройку относительно 
начальных значений, установленных по умолчанию сразу по-
сле установки программы Microsoft Word версии 2013 и стар-
ше.  

В параметрах программы (рис. 3.1) в разделе «Показы-
вать содержимое документа» необходимо включить «Затемне-
ние полей» в значение «Всегда». Это позволит визуально нахо-
дить все поля, которые используются в документе. Такие поля 
будут выделены серым цветом только при просмотре, а при пе-
чати текст останется на белом фоне. 



 

 

 

Рис. 3.1. Параметры Word 

Также рекомендуется включить на панели инструментов 
«Вид» отображение «Линейки» и «Области навигации». 

3.1.2. Оформление документа 

Как правило, любой документ необходимо оформлять, 
соответствуя определенным стандартам. В данном случае мы 
будем использовать СТП ВГТУ 62-2007 [14], который устанав-
ливает общие требования к структуре и правилам оформления 
текстовых документов и распространяется на курсовые работы 
(проекты), рефераты, контрольные работы, отчеты о лабора-
торных работах, выполняемые студентами всех кафедр ВГТУ. 



 

Требования настоящего стандарта являются обязательными 
при их оформлении. 

3.1.3. Параметры печати 

По требованиям необходимо установить размеры полей 
при печати. Для этого необходимо на панели инструментов пе-
рейти на вкладку «Разметка страницы» и выбрать пункт «По-
ля» в разделе «Параметры страницы».  

 

 

Рис. 3.2. Параметры страницы 

Далее выбираем «Настраиваемые поля» и изменяем зна-
чения в соответствии с требованиями (рис. 3.2). 



 

3.1.4. Стили текста 

Оформление документов рекомендуется осуществлять 
через стили текста. Они представлены в блоке «Стили», кото-
рый можно отобразить, если нажать сочетание клавиш 
«Alt + Ctrl + Shift + S», или на панели инструментов выбрать 
вкладку «Главная» и найдите соответствующий блок инстру-
ментов.  

В большинстве случаев мы будем использовать стили: 
 
- «Обычный»; 
- «Заголовок 1», «Заголовок 2» и т.д.; 
- «Подзаголовок»; 
- «Название объекта»; 
- «Оглавление 1», «Оглавление 2» и т.д. 
 
В программе MS Word большинство стилей основаны 

на стиле «Обычный. Это значит, что любой такой стиль насле-
дует все свойства родительского стиля, если свойство не уста-
новлено вручную. Такой подход в настройке программы поз-
воляет нам использовать и еще одну приятную особенность. 
Если свойства стилей совпадают, то при изменении этого свой-
ства у стиля «Обычный», оно автоматически изменится у всех 
наследуемых стилей. 

3.1.4.1. Стиль «Обычный» 

Приступим к настройке стилей для удоавлетворения 
требованиям СТП. Для начала необходимо изменить настройки 
стиля «Обычный». Для этого в окне «Стили» находим 
необходимый стиль, нажимаем на нем ПКМ и выбираем в 
контекстном меню пункт «Изменить».  

Если все сделано правильно, то появится окно 
«Изменение стиля», представленное на рис. 3.3. 



 

В этом окне показаны основные наиболее используемые 
настройки стиля. Однако при желании можно открыть 
расширенный набор параметров, если нажать на кнопку 
«Формат» в левой нижней части окна. Наиболее 
используемыми параметрами в меню «Формат» являются 
«Шрифт» и «Абзац». 

 

 

Рис. 3.3. Окно изменения стиля 

Выберите пункт «Шрифт» в меню «Формат» и измените 
настройки шрифта стиля в соответствии с рис. 3.4.  

Затем выберите пункт «Абзац» в меню «Формат» и 
измените настройки абзаца стиля в соответствии с рис. 3.5. 

 



 

 

Рис. 3.4. Окно настройки шрифта 

 



 

 

Рис. 3.5. Окно настройки абзаца стиля «Обычный» 

Таким образом вы можете настроить стиль под необхо-
димые требования. 



 

3.1.4.2. Стили «Подзаголовок» и «Заголовок»  

При оформлении курсовой или дипломной работы вам 
необходимо будет определять различные разделы документа. 
Это можно осуществить с помощью заголовков или подзаго-
ловков, для которых также необходимо настроить соответ-
ствующие стили.  

Такие заголовки разделов, как «Введение», «Заключе-
ние», «Список литературы» необходимо выполнить в стиле 
«Подзаголовок», и которые не должны нумероваться. А вот 
логические разделы вашей работы оформить в стиле «Заголо-
вок 1», «Заголовок 2» и т.д. и нумеровать их в зависимости от 
уровня вложенности. 

 

 

Рис. 3.6. Изменение стиля 



 

Порядок изменения параметров стилей является анало-
гичным стилю «Обычный», как показано в разделе 3.1.4.1. В 
результате значения параметров данных стилей должны соот-
ветствовать требованиям.  

Таким образом, настройки шрифта стиля «Подзаголо-
вок», «Заголовок 1», «Заголовок 2» и т.д. (рис. 3.7) будет соот-
ветствовать рис. 3.4.  

 

 

Рис. 3.7. Настройка шрифта стилей заголовков 



 

 

 

Рис. 3.8. Настройка отступов и интервалов абзаца 

А вот настройка абзаца этих стилей (рис. 3.8) будет от-
личаться от стиля «Обычный»: значения интервала «Перед» и 
«После» здесь равны нулю.  

Обратите внимание, что для всех стилей в окне «Изме-
нение стиля» (рис. 3.6) необходимо обязательно ставить фла-
жок в поле «Обновлять автоматически». В этом случае при из-



 

менении настроек все элементы текста данного стиля будут 
автоматически переформатированы. 

 

 

Рис. 3.9. Настройка положения на странице абзаца 

На вкладке «Положение на странице» (рис. 3.9) реко-
мендуется поставить галочку на значении «не отрывать от сле-



 

дующего», чтобы текст заголовка располагался с текстом все-
гда на одной странице. При необходимости вы можете активи-
ровать «с новой страницы» для заголовков, которые всегда 
должны начинаться с новой страницы. 

 

 

Рис. 3.10. Многоуровневый список для заголовков 

При необходимости для стилей «Заголовок 1» и т.д. 
можно сделать автоматическую нумерацию. Для этого выбери-



 

те абзац текста со стилем «Заголовок 1» и на панели инстру-
ментов во вкладке «Главная» выберите пункт «Многоуровне-
вый список» и в библиотеке списков выберите, как показано на 
рис. 3.10. Обратите внимание, что для нумерации заголовков 
требуется выбирать именно такой тип нумерации. 

3.1.5. Объекты и перекрестные ссылки 

Почти в любом документе встречаются графические 
объекты, таблицы, формулы, которые необходимо нумеровать. 
С этой проблемой сталкиваются, когда такие объекты вслед-
ствие редактирования могут менять свое положение в тексте, 
из-за чего ссылки на них, встречающиеся в тексте, идут не по 
порядку, что не соответствует требованиям СТП. С этой целью 
нужно использовать «Перекрестные ссылки». 

3.1.6. Оформление рисунков 

С целью создания автоматической нумерации рисунков 
и ссылок на них в документе мы будем использовать инстру-
менты «Название объекта» и «Перекрестные ссылки». Чтобы 
вставить название для рисунка необходимо либо нажать ПКМ 
на рисунке и в контекстном меню выбрать «Вставить назва-
ние», либо выбрать на панели инструментов «Ссылки – Вста-
вить название». В результате появится окно, показанное на 
рис. 3.11.  

В этом окне мы должны в разделе «Параметры» выбрать 
значение подпись: «Рисунок». По умолчанию все объекты с 
таким параметром подписи будут иметь свою сквозную нуме-
рацию, т.е. по порядку вне зависимости от раздела, котором 
находятся. 

Если нажать кнопку «Нумерация» (рис. 3.11) и устано-
вить в новом окне «Нумерация названий» флажок на пункте 
«Включить номер главы» и не забудьте выбрать в качестве 



 

разделителя «точку» (рис. 3.12), то нумерация будет осуществ-
ляться относительно номера заголовка. 

Конечно, подпись содержит только постоянную часть, 
которую надо дополнить, т.е. дать название рисунку. Как при-
мер, можно посмотреть на подпись к любому рисунку в дан-
ном документе. 

 

 

Рис. 3.11. Название объекта 

 



 

 

Рис. 3.12. Нумерация названий 

Использование перекрестных ссылок позволит вам ссы-
латься на подпись к объекту, сохраняя связь между порядко-
вым номером. 

 

 

Рис. 3.13. Группа «Названия» инструмента «Ссылки» 

Чтоб вставить в тексте ссылку на рисунок (или другой 
объект с подписью) необходимо найти на панели инструментов 
«Ссылки», в которой выбрать «Перекрестная ссылка» 
(рис. 3.13). В результате появится окно, показанное на 
рис. 3.14. 



 

Выберите «Тип ссылки», на который хотите сослаться в 
тексте (в нашем случае это значение «Рисунок»). После выбора 
нужного типа появится список всех объектов в тексте, которым 
присвоен выбранный тип ссылки. Так как для наших рисунков 
вы сделали дополнительную подпись, можно легко ориентиро-
ваться среди множества строк.  

Однако после вставки появится фраза «Рисунок 1.1», 
которая является автоматическим клоном основной части под-
писи, т.е. если изменится основная часть подписи, то автома-
тически изменится текст нашей ссылки.  

Примечание. Редактировать текст самой ссылки не 

приведет к сохранению текста и при последующем обновлении 

полей, будет восстановлено в исходное значение.  
 

 

Рис. 3.14. Окно «Перекрестные ссылки» 

Также установите пункт «Вставить ссылку на» в значе-
ние «Постоянная часть и номер». Это необходимо, чтобы текст 



 

ссылки, который будет отображаться, содержал только основ-
ную часть подписи, исключая дополнительную информацию. 

 

 

Рис. 3.15. Составляющие перекрестной ссылки на рисунок 

Примечание: Перекрестные ссылки вставляются в до-

кумент в виде полей (Поле – набор кодов, обеспечивающих ав-

томатическую вставку в документ текста, рисунков, номеров 

страниц и других сведений). Если вместо название перекрест-

ной ссылки отображается текст типа {REF _Ref249586 \* 

MERGEFORMAT}, значит включен режим отображения кодов 

полей (Код поля – текстовый заполнитель, показывающий ме-

сто, где будут отображаться указанные сведения из источ-

ника данных; элементы, генерирующие результат поля. Коды 

поля включают знаки поля, тип поля и инструкции.), а не зна-

чений полей (Значения полей – текст или графические объек-

ты, вставленные в документ в результате выполнения про-

граммой Microsoft Word инструкций, содержащихся в полях. 

Когда выполняется печать документа или скрыты коды по-

лей, вместо кодов полей в документе отображаются значения 

полей.). Чтобы просмотреть значения полей, нажмите кла-

виши ALT+F9 или щелкните правой кнопкой мыши код поля, а 

затем выберите в контекстном меню команду «Ко-

ды/значения полей». 

Рисунок 1.1 – Вольтамперная характеристика 
 

Номер Постоянная 
часть 

 

Название 



 

3.1.7. Оформление таблиц 

Для автоматической нумерации таблиц в тексте необхо-
димо сделать похожие действия, как и в предыдущем разделе. 
Отличием является только то, что параметр «Подпись» необ-
ходимо установить в значение «Таблица». К тому же часто 
подпись к таблице необходимо разместить над объектом, что 
может быть изменено в параметре «Положение». 

3.1.8. Оформление формул 

Нумерация формул также будет использовать инстру-
мент «Названия объекта» и «Перекрестные ссылки».  

Учитывая требования предприятия [14] по оформлению 
формул, предлагается использовать следующий подход. 

Создайте пустую таблицу с 1 строкой и 2 колонками, в 
свойствах созданной таблицы в разделе «Границы и заливка» 
значение поля «Тип» границы поставьте в значение «Нет». Для 
удобства визуального восприятия текста также рекомендуется 
установить на вкладке «Конструктор» (эта вкладка появится, 
если поместить курсор в любое поле таблицы) найти кнопку 
«Границы» и затем установить активным значение «Отобра-
зить стеку», которая отображается только при просмотре до-
кумента, а при печати будет скрыта. 

Установите для всей таблицы вертикальное выравнива-
ние по центру, выполнив следующие действия: выделить все 
ячейки таблицы и выбрать на панели инструментов «Макет → 
Выровнять по центру».  

Установите курсор в правую ячейку и выберите на па-
нели инструментов «Ссылки – Вставить название». Необходи-
мо выбрать тип подписи «Формула», установить нумерацию 
названий по главе раздела с разделителем в виде точки. Также 
необходимо исключить подпись из названия. 



 

Необходимо, чтобы номер формулы был выровнен по 
правому краю, а сама формула по центру. Для этого установите 
соответствующие выравнивания в ячейках таблицы, изменив 
при этом ширину ячеек, с помощью разделительной границы. 

В результате появится поле, содержащее номер форму-
лы, с учетом номера текущего раздела (рис. 3.16). 

 

 

Рис. 3.16. Пример оформления формулы 

Теперь вы можете ссылаться на эту формулу в тексте с 
помощью инструмента «Перекрестные ссылки», выбрав при 
этом соответствующий тип ссылки. Однако в данном случае 
вставлять ссылку нужно, выбрав в настройках «Название цели-
ком». 

3.1.9. Автоматизация списка литературы 

Нумерация списка литературы использует инструмент 
«Названия объекта» и «Перекрестные ссылки», однако по 
умолчанию в программе такого типа ссылки нет. Поэтому ре-
комендуется создать новое название (рекомендуется использо-
вать «Список литературы»). В результате появится новый «Тип 
ссылки», который можно использовать. 

Обратите внимание, что данный тип ссылки будет до-

ступен только на том ПК, на котором вы его создали. То 

есть, если вы откроете документ на другой машине, напри-

мер, дома или на работе, то созданный ранее тип ссылки не 

будет отображаться. Поэтому необходимо будет его со-

здать, соблюдая точность формулировки. 



 

3.1.10. Работа с закладками 

Вы можете использовать инструмент «Перекрестные 
ссылки» не только для названия объектов, но и для выделен-
ных фрагментов текста. Закладки могут быть полезны, когда 
вы используете, одинаковый текст на разных листах докумен-
та.  

Такой подход поможет избежать ошибок при копирова-
нии или редактировании текста, так как уменьшает ошибки 
при наборе текста, связанные с человеческим фактором (опе-
чатки, забывчивость и т.д.). 

 

 

Рис. 3.17. Инструмент «Закладка» 

Для этого нужно выделить текст и добавить его в за-
кладки с помощью инструмента «Закладка», создав необходи-
мое вам имя закладки (например, «Организация», «Тема» и 
т.д.).  



 

После этого вы можете сделать перекрестную ссылку в 
любом месте документа, выбрав соответствующий тип ссылки 
на рис. 3.14, при этом вставлять ссылку в отличие от рисунков, 
таблиц и формул следует целиком. 

3.1.11. Полезные команды быстрого вызова 

Работая с текстом в документе, вы выполняете различ-
ные однотипные действия. Чтобы сэкономить время рекомен-
дуется использовать, так называемый быстрый доступ к ин-
струментам программы.  
 

Таблица 3.1. Команды быстрого доступа программы MS Word 
Команды Действие 


�� + ���� + �ℎ��� + � Отобразить/скрыть блок «Стили» 
���� + 
 Выделить весь документ 
�9  Обновить все ссылки в выделенном фрагменте 

документа. Предварительно необходимо выделить 

весь текст. 

�ℎ��� + �3 Изменить регистр выделенного текста  
Например, «ВСЕ ПРОПИСНЫЕ», «все строчные» 

���� + "�#$% �&$'()*+� Тире. 
Иногда вместо дефиса необходимо использовать 

тире 

���� + �ℎ��� + "�#$% Неразрывный дефис. 
Используется чтобы не разрывать слово для пере-

носа там, где необходим дефис. 

Например: КОМПАС-3D,  

���� + �ℎ��� + ��,*� Неразрывный пробел.  
Используется, чтобы единицы измерения не отде-

лялись от значения в конце строки. Например, 

100 мкм, рисунок 1.2 и т.д. 
���� + -&.-/ Разрыв страницы 
�ℎ�� + -&.-/ Разрыв строки 

�� + ���� + 0 Специальная вставка текста из буфера обмена. 

Используется, при копировании текста из Интер-

нет-ресурсов, чтобы сохранить стиль оформления 

текста. Рекомендуется выбирать значение «Не-

форматированный текст». 



 

С полным перечнем команды быстрого доступа вы мо-
жете ознакомиться в справке программы, которая может быть 
вызвана с помощью нажатия кнопки F1 на клавиатуре. 

Использование таких комбинаций поможет вам значи-
тельно ускорить и упростить работу в программе. 

3.1.12. Печать документа 

Настоятельно рекомендуется перед печатью сохранить 
документ как PDF файл, используя «Файл → Сохранить как».  

Затем необходимо открыть сохраненный файл *.pdf и 
пролистать его от начала до конца, проверив на наличие оши-
бок в оформлении документа соответствующим требованиям. 

Только после этого можно отдавать документ на печать 
в формате *.pdf в печатный центр.  

Такой подход необходим в связи с тем, что разные вер-
сии программ могут открывать документ с нарушением 
оформлением текста (например, исчезают пробелы между 
слов, смещение текста на странице и т.д.).  

Поэтому использование проверенного документа в 
формате PDF позволит гарантированно получить точную бу-
мажную копию электронного документа. 

3.2. Порядок выполнения работы 

3.2.1 Найдите в интернете описание программ, которые 
вы использовали в течение учебной практики. 

3.2.2 Составьте отчет по разделам на каждую програм-
му, который должен включать по каждой изученной компью-
терной программе разделы с описанием выполненной работы, 
в том числе с рисунками, таблицами и формулами. 

3.2.3 Оформите отчет по практике в соответствии с тре-
бованиями [14]. 



 

3.3. Контрольные вопросы 

3.3.1 Что такое поля документа? 
3.3.2 Какие возможности работы со стилями документа 

вы знаете? 
3.3.3 Где и каким образом применяется многоуровневая 

нумерация? 
3.3.4 Как автоматически формировать автоматически 

собираемое оглавление? 
3.3.5 Как автоматически нумеровать рисунки, таблицы, 

формулы, список литературы?  
3.3.6 Какие составляющие перекрестной ссылки вы зна-

ете? 
3.3.7 С какими особенностями нумерации формул вы 

можете столкнуться? 
3.3.8 Как изменить сквозную нумерацию на нумерацию 

по разделам? 
3.3.9 Что такое требования предприятия по оформле-

нию документов и где их можно найти? 
3.3.10 Что такое закладки и как их можно использо-

вать? 
3.3.11 Какие команды быстрого доступа вы знаете и для 

чего они нужны? 
3.3.12 Как необходимо печатать документ в сторонних 

организациях? 
  



 

ЗАКЛЮЧЕНИЕ 

Умение работать с современным программным обеспе-
чением необходимая составляющая в современном мире. Ис-
пользование таких программных продуктов повышает ско-
рость и качество работы сотрудников. 

В пособии приведены лишь некоторые основные про-
граммы, которые используются в научных лабораториях и ис-
следовательских центрах.  

Пособие не претендует на роль полного описания воз-
можностей работы в программах, а носит лишь практические 
рекомендации, которым по мнению автора необходимо уде-
лить особое внимание. 

Учебное пособие «Учебная практика» предназначено 
для проведения учебной практики для бакалавров в рамках вы-
полнения практических заданий, поэтому оно содержит сведе-
ния о работе в компьютерных программах, краткое описание 
возможностей, практические рекомендации и контрольные во-
просы для самопроверки. 

Последовательное изложение учебного материала 
должно способствовать глубокому усвоению студентами дис-
циплины «Учебная практика». 

Данное учебное пособие окажет существенную помощь 
студентам по направлениям 16.03.01 «Техническая физика», 
28.03.01 «Нанотехнологии и микросистемная техника», 
14.03.01 «Ядерная энергетика и теплофизика» очной формы 
обучения для повышения навыков работы с программным 
обеспечением. 
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